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Požadavky na zpracování výsledků 

Výsledky jednotlivých cvičení budou zpracovány do protokolu, který bude mít následující 
náležitosti: 

• Jméno a příjmení, název cvičení a datum 
• Pro každý tematický okruh: 

• Stručné shrnutí tématu včetně reakčního schématu, pokud je to vhodné 
• Použitý software včetně verzí 
• Výsledky (tabulky) 
• Diskuze výsledků dle zadání 
• Použitá literatura (např. u experimentálních hodnot) 

Protokol ve formátu pdf je nutné odevzdat do 9.11. 24:00 do odevzdávárny CV1 
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Molekula vody 
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Úkoly 

1) Vytvořte model molekuly vody a jeho geometrii zoptimalizujte pomocí molekulové 
mechaniky. 

2) Zoptimalizujte geometrii molekuly vody pomocí metody HF/cc-pVDZ 
3) Změřte významné geometrické parametry optimalizované geometrie a srovnejte je s 

výchozím modelem. 
4) Ověřte, že nalezená geometrie odpovídá lokálnímu minimu na PES, pomocí vibrační 

analýzy. 
5) Pro optimalizovanou geometrii proveďte výpočet energie včetně výpisu průběhu SCF 

výpočtu, dipólového momentu a Mullikenových a MK (Merz-Singh-Kollman) 
atomových nábojů pomocí metody HF/cc-pVDZ 

6) Na stejné geometrii opakujte výpočet uvedený v bodě 4 pro báze: cc-pVTZ, cc-pVQZ a 
cc-pV5Z 

7) Energii molekuly vody extrapolujte na CBS (Complete Basis Set), tj. určete hodnotu 
energie pro metodu HF/CBS 

8) Extrapolujte dipólový moment na CBS hodnotu. 
9) Srovnejte hodnotu vypočteného dipólového momentu s experimentální hodnotou, 

případný rozdíl diskutujte.  
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Řešení 

1) Počáteční geometrii molekuly vody vytvořte v programu Avogadro nebo Nemesis. 
Geometrii modelu předoptimalizujeme pomocí molekulové mechaniky (silového pole).  
Zvolte takové silové pole, které dle vašeho názoru nejlépe vystihne geometrii molekuly 
vody. Předoptimalizované geometrie uložte ve formátu xyz  pod názvem water.xyz do 
složky 00.input 

Štábní kultura 
00.input 
01.opt 
02.freq 
03.props 
 01.cc-pVDZ 
 02.cc-pVTZ 
    03.cc-pVQZ 
 04.cc-pV5Z  

2) Soubor water.xyz překopírujte do adresáře 01.opt a přejmenujte jej na opt.com. 
Přejmenovaný soubor otevřete v textovém editoru a změňte jej na vstupní soubor pro 
optimalizaci geometrie v programu Gaussian.  Spusťtě výpočet. 
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Řešení 
3) V adresáři 01.opt otevřete soubor opt.log v textovém editoru a analyzujte jeho obsah. 
Ověřte, že výpočet proběhl v pořádku a nalezněte optimalizovanou geometrii. Soubor 
zavřete. Ze souboru opt.log vyextrahujte informace o změně energie, dále odpovídající 
geometrie a optimalizovanou geometrii do souboru s názvem last.xyz pomocí skriptů z 
modulu qmutil.  Soubor last.xyz otevřete v programu vmd, Avogadro, či Nemesis a změřte 
významné geometrické parametry. 

5) Soubor last.xyz překopírujte do adresáře 03.props/01.cc-pVDZ a přejmenujte jej na 
props.com. Přejmenovaný soubor otevřete v textovém editoru a upravte jeho obsah pro 
výpočet energie metodou HF/cc-pVDZ. Zvolte úplný výpis (#P) a výpočet ESP atomových 
nábojů metodou Merz-Singh-Kollman (Pop=MK).  Spusťte výpočet. Výstupní soubor 
props.log otevřete v textovém editoru a vyextrahujte z něj data do dále uvedené tabulky. 

6) Postupujte analogicky jako v bodě 5, použijte postupně metody: HF/cc-pVTZ, HF/cc-
pVQZ, HF/cc-pV5Z 

4) Soubor last.xyz překopírujte do adresáře 04.freq a přejmenujte jej na freq.com. 
Přejmenovaný soubor otevřete v textovém editoru a upravte jeho obsah pro výpočet 
normálních vibrací na úrovni teorie HF/cc-pVDZ. Spusťte výpočet. Výstupní soubor freq.log 
otevřete v textovém editoru a určete typ stacionárního bodu. Normální vibrace zobrazte v 
programu Avogadro nebo Nemesis.  
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Řešení 
6) (aug-)cc-pVXZ jsou konzistentně korelační báze, které vykazují exponenciální pokles 
energie systému se vzrůstající velikostí báze.  Tento fakt lze využít k extrapolaci energie na 
úplnou bázi (CBS – complete basis set neboli HF-limitu).  

Bx

CBS
AeExE


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kde x je číselné vyjádření pro X: 2 (D), 3 (T), 4 (Q) 

ECBS, A, B jsou neznámé konstanty, které lze učit z hodnot energie pro tři hodnoty x (báze). 

xB

CBS
eAPxP

'
'
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
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7) Podobná závislost platí i pro jiné vlastnosti systému, např. dipólový moment,  frekvence 
vibrace, geometrický parametr, apod. 
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Výsledky 

Metoda MM HF/cc-pVTZ Rozdíl 

d(HO) [Å] 

Q(HOH) [˚] 

Geometrie molekuly vody 

doplňte použité silové pole 
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Výsledky 

SCF Krok  E [au] DEprev [au] 

1 --- 

2 

3 

4 

... 

Molekula vody – průběh SCF metody 
HF/cc-pVDZ 

doplňte podle skutečného počtu 
SCF kroků 

změna energie vůči předchozímu 
kroku 

Poznámka: Hodnoty energie vyextrahujte ze souboru manuálně nebo použijte příkaz grep. 
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Výsledky 

Mulliken MK ESP 

Báze E [au] Er [kcal/mol] m [D] q(H) q(O) q(H) q(O) 

cc-pVDZ 0,0 

cc-pVTZ 

cc-pVQZ 

cc-pV5Z 

CBS ---- ---- ---- ---- 

Molekula vody 

výsledek výpočtu 
absolutní energie (E(RHF)) 

relativní energie vůči bázi cc-pVDZ 
dipólový elektrostatický moment 

atomové náboje 
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Dimer molekuly vody 
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Úkoly 

1) Vytvořte model dimeru molekuly vody a jeho geometrii zoptimalizujte pomocí 
molekulové mechaniky. 

2) Zoptimalizujte geometrii dimeru molekuly vody pomocí metody HF/cc-pVDZ 
3) Změřte významné geometrické parametry optimalizované geometrie a srovnejte je s 

výchozím modelem. Pozorované rozdíly se pokuste zdůvodnit. 
4) Ověřte, že nalezená geometrie odpovídá lokálnímu minimu na PES, pomocí vibrační 

analýzy. 
5) Pro optimalizovanou geometrii proveďte výpočet energie se započítáním BSSE korekce. 
6) Na stejné geometrii opakujte výpočet uvedený v bodě 4 pro báze: cc-pVTZ, cc-pVQZ a 

cc-pV5Z 
7) Energii dimeru molekuly vody extrapolujte na CBS (Complete Basis Set), tj. určete 

hodnotu energie pro metodu HF/CBS 
8) Pro každou bázi určete interakční energii mezi molekulami vod. Srovnejte ji s hodnotou 

vypočtenou s použitím úplné báze. Srovnejte hodnotu interakční energie s hodnotou 
BSSE chyby. Výsledky diskutujte. 
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Řešení 

Postupuje se analogicky jako v předchozím případě. Do výpočtu energie je však nutné 
zahrnout korekci na BSSE (Counterpoise=2 + definice fragmentů).   

Štábní kultura 
00.input 
01.opt 
02.freq 
03.props 
 01.cc-pVDZ 
 02.cc-pVTZ 
    03.cc-pVQZ 
 04.cc-pV5Z  
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Výsledek 

Metoda MM HF/cc-pVTZ Rozdíl 

d(HO) [Å] 

Q(HOH) [˚] 

d(H...O) [Å] 

Geometrie dimeru molekuly vody 

doplňte použité silové pole 

vodíková vazba 

Dle vlastního uvážení uveďte další geometrické parametry, které nejlépe postihnou rozdíl 
mezi oběma geometriemi. 
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Výsledek 

Báze E  Er EBSSE EBSSE Ei 

[au] [kcal/mol] [au] [kcal/mol] [kcal/mol] 

cc-pVDZ 0,0 

cc-pVTZ 

cc-pVQZ 

cc-pV5Z 

CBS 

výsledek výpočtu 
absolutní energie včetně korekce na BSSE 

relativní energie vůči bázi cc-pVDZ 

interakční energie mezi 
molekulami vody 

Dimer molekuly vody 

monomereri
EEE *2

dim

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Bambus[6]uril 
Vazba aniontů do kavity BU[6] 
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Úkoly 

1) Namodelujte geometrii komplexu BU[6] s chloridovým aniontem. 
2) Zoptimalizujte geometrii komplexu pomocí semiempirické kvantově chemické metody 

PM3. 
3) Za použití optimalizované geometrie připravte model komplexu BU[6] s bromidovým 

aniontem a samotný BU[6]. 
4) Zoptimalizujte geometrie komplexu Br-@BU[6] a BU[6] metodou PM3. 
5) Ověřte, že nalezené geometrie odpovídají lokálním minimům na PES, pomocí vibrační 

analýzy. 
6) Vypočítejte vazebnou energii chloridového a bromidového aniontu do BU[6]. Výsledky 

srovnejte s experimentálními hodnotami vazebných afinit 
7) Zobrazte elektrostatický potenciál namapovaný na povrch elektronové hustoty pro 

molekulu BU[6]. Zobrazení použijte k vysvětlení vazby aniontů do kavity bambusurilu. 
8) Výpočet interakční energie zopakujte pomocí metody PM6. Získané výsledky srovnejte 

s metodou PM3. 
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Řešení 
Štábní kultura 

00.input 
01.PM3 

01.BU6Cl 
01.opt 
02.freq 

02.BU6Br 
01.opt 
02.freq 

03.BU6 
01.opt 
02.freq 
03.surface 

02.PM6 
01.BU6Cl 
02.BU6Br 
03.BU6   

Poznámka:  Energie je možné brát z posledního kroku optimalizace geometrie.  
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Řešení 
7) Z adresáře 02.PM3/03.BU6/01.opt překopírujte soubor last.xyz do adresáře 
02.PM3/03.BU6/03.surface a přejmenujte jej na surface.com. Přejmenovaný soubor 
otevřete v textovém editoru a upravte jeho obsah pro výpočet energie na úrovni teorie 
HF/cc-pVDZ. V souboru uveďte jméno archivu (checkpointu) jako surface.chk. Spusťte 
výpočet.  Po dokončení výpočtu vypočítejte elektronovou hustotu a elektrostatický 
potenciál pomocí utility cubegen z modulu gaussian. 

$ module add gaussian 

$ formchk surface.chk 

$ cubegen 0 density=scf surface.fchk density.cube 0 h 

$ cubegen 0 potential=scf surface.fchk esp.cube 0 h  

Soubory density.cube a esp.cube zobrazte v programu VMD. 

Vytvoří formátovaný archiv, který je 
využíván v dalších analýzách. 
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Výsledek 

PM3 PM6 

Cl- Br- Cl- Br- 

E [au] E [au] E [au] E [au] 

BU[6] 

X 

X@BU[6] 

Ei [au] 

Ei [kcal/mol] 

interakční energie 

)(
]6[]6[@ BUXBUXi

EEEE 
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Gaussian 

http://www.gaussian.com 

Nápověda:  
Tech Support  -> Gaussian 09 Help: 

•  Table of Contents 
•  Keyword List 

!!! Všechny výstupy níže uvedené jsou pouze ukázkami !!! 
Jejich obsah nesouvisí s řešenými úkoly. 
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Vstupní soubor 

%chk=h2o.chk 

# RHF/cc-pVDZ Opt 

 

optimalizace geometrie molekuly vody 

 

0 1 

 O     0.000000     0.000000    -0.154167 

 H     0.000000     0.854766     0.538096 

 H     0.000000    -0.854766     0.538096 

specifikace geometrie systému (kartézské souřadnice v Å) 
zakončena prázdným řádkem 

prázdný řádek 

prázdný řádek 

prázdný řádek 

Link0 příkazy  – uvozeny %, lze použít pro specifikaci jména archivu (checkpoint), množství 
paměti, počtu procesorů určených pro výpočet   (všechny položky jsou 
volitelné) 

Příkazová řádka – uvozena #, specifikuje typ výpisu (viz Route (#)), metodu a typ výpočtu 

metoda báze vlnové funkce 

optimalizace geometrie 

náboj 

multiplicita 
M=2S+1 

celkový spin 
elektronů 
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Výpočet energie a optimalizace 

%chk=h2o.chk 

# RHF/cc-pVDZ Opt Pop=ChelpG 

 

optimalizace geometrie molekuly vody 

 

0 1 

 O     0.000000     0.000000    -0.154167 

 H     0.000000     0.854766     0.538096 

 H     0.000000    -0.854766     0.538096 

%chk=h2o.chk 

# RHF/cc-pVDZ Pop=MK 

 

vypocet energie molekuly vody 

 

0 1 

 O     0.000000     0.000000    -0.154167 

 H     0.000000     0.854766     0.538096 

 H     0.000000    -0.854766     0.538096 

bez klíčového slova Opt 
pouze výpočet energie, 
vlnové funkce a vlastností 
systému  
(single point výpočet) 

zakončeno prázdným řádkem 

zakončeno prázdným řádkem 
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Průběh výpočtu 
Výpočet energie Optimalizace geometrie 

Vstupní geometrie 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

Vstupní geometrie 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

Optimalizovaná 
geometrie 

výpočet gradientu E 

lokální 
minimum? 

ano 

ne 

odhad vlnové funkce pro 
následující krok se bere z 
kroku předchozího 

2 

3 

4 

5 

7 

6 

2 

3 

7 

1 1 

změna geometrie 

5 

Populační analýza a 
výpočet vlastností 

systému 

7 pro vstupní geometrii 
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Vibrační analýza 

%chk=h2o.chk 

# RHF/cc-pVDZ Freq 

 

vibracni analyza 

 

0 1 

O      0.0000000      0.0000000     -0.0780430 

H      0.0000000      0.7492420      0.5000340 

H      0.0000000     -0.7492420      0.5000340 

zakončeno prázdným řádkem 

Pokud je vstupní geometrie stacionárním bodem na PES, lze z počtu imaginárních 
frekvencí  normálních vibrací určit typ stacionárního bodu. 
 0 imaginárních frekvencí = lokální minimum 
  1 imaginární (záporná) frekvence = tranzitní stav prvního řádu 
 
Vibrační analýza vyžaduje výpočet Hessianu, což může být výpočetně velmi náročné.  
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Průběh výpočtu 
Výpočet energie 

Vstupní geometrie 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

2 

3 

1 

Populační analýza a 
výpočet vlastností 

systému 

výpočet gradientu E 

výpočet Hessianu E 

Výpočet frekvencí 
vibrací 

Termodynamické 
vlastnosti 

8 

8 

7 
9 10 

Test na stacionární 
bod 

5 

Je použit model ideálního plynu! 

Harmonická aproximace 
Harmonická aproximace je 

platná pouze pro 
stacionární bod na PES 
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CP korekce na BSSE 

%Chk=ene.chk 

# RHF/cc-pVDZ Counterpoise=2 

 

vypocet energie s korekci na BSSE 

 

0 1 

 O(Fragment=1)     0.231135     0.063539     0.203312 

 H(Fragment=1)     0.374693     0.253491     1.116647 

 H(Fragment=1)     0.074728    -0.864502     0.130817 

 O(Fragment=2)    -1.648273     1.893276    -1.229780 

 H(Fragment=2)    -1.166742     2.355543    -1.894982 

 H(Fragment=2)    -1.036494     1.311764    -0.798971 

zakončeno prázdným řádkem 

Výpočet energie s 
korekcí na BSSE  

Fragmenty představují interagující molekuly. 

Counterpoise korekce na BSSE vyžaduje celkem 5 výpočtů energie[AB, A(B), (A)B, A, B], 
které program Gaussian provede automaticky.  
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Průběh výpočtu 

Vstupní geometrie 
1 

Korigovaná energie 

11 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

2 

3 

7 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

2 

3 

7 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

2 

3 

7 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

2 

3 

7 

Odhad vlnové funkce 
(Guess) 

Výpočet E a vlnové 
funkce (SCF) 

Populační analýza a 
výpočet vlastností 

systému 

2 

3 

7 

AB A(B) (A)B A B 

)()(
)()( BABBAAABCP

EEEEEE 

BSSE 
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Spuštění výpočtu 
$ module add gaussian 

$ g09 soubor.com 

aktivace modulu gaussian 
pouze jednou v daném terminálu 

jméno vstupního souboru 

program gaussian 

Po doběhnutí úlohy bude výsledek výpočtu uložen v souboru soubor.log, na posledním 
řádku souboru musí být uvedeno:  

 Normal termination of Gaussian 09 at Sun Oct 26 20:20:09 2014. 

v opačném případě je výpočet neúspěšný.  Důvod předčasného ukončení výpočtu je nutné 
hledat ve výstupním souboru. 

Na klastru WOLF je doporučeno výpočty 
zadávat do dávkového systému pomocí 

rozhraní Infinity.  
Tento postup je podrobně popsán v následující 

kapitole. 
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Výstupní soubor I a II 

                           ---------------------------- 

                           !    Initial Parameters    ! 

                           ! (Angstroms and Degrees)  ! 

 --------------------------                            -------------------------- 

 ! Name  Definition              Value          Derivative Info.                ! 

 -------------------------------------------------------------------------------- 

 ! R1    R(1,2)                  1.0999         estimate D2E/DX2                ! 

 ! R2    R(1,3)                  1.0999         estimate D2E/DX2                ! 

 ! A1    A(2,1,3)              101.9929         estimate D2E/DX2                ! 

 -------------------------------------------------------------------------------- 

1. Vstupní geometrie v interních souřadnicích 

2. Odhad vlnové funkce 

 Two-electron integral symmetry is turned off. 

    24 basis functions,    47 primitive gaussians,    25 cartesian basis functions 

     5 alpha electrons        5 beta electrons 

       nuclear repulsion energy         8.0071357792 Hartrees. 

 NAtoms=    3 NActive=    3 NUniq=    3 SFac= 1.00D+00 NAtFMM=   60 NAOKFM=F Big=F 

 One-electron integrals computed using PRISM. 

 NBasis=    24 RedAO= T  NBF=    24 

 NBsUse=    24 1.00D-06 NBFU=    24 

 Harris functional with IExCor=  205 diagonalized for initial guess. 

počet bázových funkci = počet koeficientů c, které je 
nutné nalézt během SCF procedury  

počáteční odhad vlnové funkce 
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Výstupní soubor III 

 SCF Done:  E(RHF) =  -75.9901319773     A.U. after   10 cycles 

             Convg  =    0.5258D-08             -V/T =  2.0057 

3. Výpočet energie a vlnové funkce 

Výsledná energie 

Změna energie v posledním kroku SCF procedury 

Počet SCF kroků potřebných k nalezení E a vlnové funkce 

viriálový teorém 

Úplný průběh SCF procedury je vypsán, pokud je ve vstupním souboru uvedeno #P 

Energie je v atomových jednotkách. 
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Výstupní soubor III, pokračování 
 Cycle   1  Pass 1  IDiag  1: 

 E= -75.9710832672194 

 DIIS: error= 4.94D-02 at cycle   1 NSaved=   1. 

 NSaved= 1 IEnMin= 1 EnMin= -75.9710832672194     IErMin= 1 ErrMin= 4.94D-02 

 ErrMax= 4.94D-02 EMaxC= 1.00D-01 BMatC= 1.08D-01 BMatP= 1.08D-01 

 IDIUse=3 WtCom= 5.06D-01 WtEn= 4.94D-01 

 Coeff-Com:  0.100D+01 

 Coeff-En:   0.100D+01 

 Coeff:      0.100D+01 

 Gap=     0.463 Goal=   None    Shift=    0.000 

 GapD=    0.463 DampG=2.000 DampE=0.500 DampFc=1.0000 IDamp=-1. 

 RMSDP=6.04D-03 MaxDP=1.13D-01              OVMax= 1.12D-01 

.... 

 Cycle  10  Pass 1  IDiag  1: 

 E= -76.0418076480768     Delta-E=        0.000000000000 Rises=F Damp=F 

 DIIS: error= 2.15D-08 at cycle  10 NSaved=  10. 

 NSaved=10 IEnMin=10 EnMin= -76.0418076480768     IErMin=10 ErrMin= 2.15D-08 

 ErrMax= 2.15D-08 EMaxC= 1.00D-01 BMatC= 8.09D-15 BMatP= 1.54D-13 

 IDIUse=1 WtCom= 1.00D+00 WtEn= 0.00D+00 

 Coeff-Com: -0.199D-06 0.154D-05 0.181D-04-0.155D-03 0.397D-03 0.649D-03 

 Coeff-Com: -0.110D-01 0.669D-01-0.441D+00 0.138D+01 

 Coeff:     -0.199D-06 0.154D-05 0.181D-04-0.155D-03 0.397D-03 0.649D-03 

 Coeff:     -0.110D-01 0.669D-01-0.441D+00 0.138D+01 

 Gap=     0.546 Goal=   None    Shift=    0.000 

 RMSDP=4.57D-09 MaxDP=4.52D-08 DE=-3.84D-13 OVMax= 8.92D-08 

 

 SCF Done:  E(RHF) =  -76.0418076481     A.U. after   10 cycles 

             Convg  =    0.4573D-08             -V/T =  2.0008 

kráceno 
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Výstupní soubor IV 

 ------------------------------------------------------------------- 

 Center     Atomic                   Forces (Hartrees/Bohr) 

 Number     Number              X              Y              Z 

 ------------------------------------------------------------------- 

      1        8           0.000000000    0.000000000    0.131133317 

      2        1           0.000000000   -0.085534245   -0.065566658 

      3        1           0.000000000    0.085534245   -0.065566658 

 ------------------------------------------------------------------- 

 Cartesian Forces:  Max     0.131133317 RMS     0.067020838 

4. Výpočet gradientu síly = záporně vzatý gradient energie (v atomových jednotkách) 
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Výstupní soubor V 

 GradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGrad 

 Berny optimization. 

 Internal  Forces:  Max     0.107734851 RMS     0.088033019 

... 

Variable       Old X    -DE/DX   Delta X   Delta X   Delta X     New X 

                                 (Linear)    (Quad)   (Total) 

    R1        2.07857  -0.10773   0.00000  -0.21160  -0.21160   1.86697 

    R2        2.07857  -0.10773   0.00000  -0.21160  -0.21160   1.86697 

    A1        1.78011  -0.00599   0.00000  -0.02126  -0.02126   1.75885 

         Item               Value     Threshold  Converged? 

 Maximum Force            0.107735     0.000450     NO 

 RMS     Force            0.088033     0.000300     NO 

 Maximum Displacement     0.177009     0.001800     NO 

 RMS     Displacement     0.154831     0.001200     NO 

 Predicted change in Energy=-3.060008D-02 

 GradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGrad 

5. Optimalizace geometrie 

kráceno 

konvergenční kritéria pro optimalizaci geometrie 

plánovaná změna geometrie 
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Výstupní soubor VI 

 Item               Value     Threshold  Converged? 

 Maximum Force            0.000267     0.000450     YES 

 RMS     Force            0.000172     0.000300     YES 

 Maximum Displacement     0.000999     0.001800     YES 

 RMS     Displacement     0.000967     0.001200     YES 

 Predicted change in Energy=-2.315429D-07 

 Optimization completed. 

    -- Stationary point found. 

                           ---------------------------- 

                           !   Optimized Parameters   ! 

                           ! (Angstroms and Degrees)  ! 

 --------------------------                            -------------------------- 

 ! Name  Definition              Value          Derivative Info.                ! 

 -------------------------------------------------------------------------------- 

 ! R1    R(1,2)                  0.9463         -DE/DX =   -0.0001              ! 

 ! R2    R(1,3)                  0.9463         -DE/DX =   -0.0001              ! 

 ! A1    A(2,1,3)              104.696          -DE/DX =   -0.0003              ! 

 -------------------------------------------------------------------------------- 

 GradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGradGrad 

6. Optimalizovaná geometrie 



C7800 Počítačová chemie a molekulové modelování I - cvičení -37- 

Výstupní soubor VII 
7. Populační analýza a výpočet vlastností systému (kráceno) 

 Alpha  occ. eigenvalues --  -20.54839  -1.34218  -0.70556  -0.56822  -0.49389 

 Alpha virt. eigenvalues --    0.18742   0.25779   0.79793   0.86396   1.16257 

 Mulliken atomic charges: 

              1 

     1  O   -0.292462 

     2  H    0.146231 

     3  H    0.146231 

 Sum of Mulliken atomic charges =   0.00000 

 Dipole moment (field-independent basis, Debye): 

    X=              0.0000    Y=              0.0000    Z=              2.0430  Tot= 2.0430 

 Quadrupole moment (field-independent basis, Debye-Ang): 

   XX=             -7.0085   YY=             -4.1369   ZZ=             -5.7327 

   XY=              0.0000   XZ=              0.0000   YZ=              0.0000 

energie molekulových orbitalů 

Mullikenovy atomové (bodové) náboje 

dipólový a kvadrupólový elektrostatický moment  

obsazené 

neobsazené 

Typ populační analýzy lze měnit pomocí klíčového slova: pop 
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Výstupní soubor VIII 

 Differentiating once with respect to electric field. 

                with respect to dipole field. 

          Electric field/nuclear overlap derivatives assumed to be zero. 

          Keep R1 ints in memory in canonical form, NReq=873499. 

          There are     3 degrees of freedom in the 1st order CPHF.  IDoFFX=0. 

      3 vectors produced by pass  0 Test12= 3.17D-15 3.33D-08 XBig12= 1.15D+00 6.84D-01. 

 AX will form     3 AO Fock derivatives at one time. 

      3 vectors produced by pass  1 Test12= 3.17D-15 3.33D-08 XBig12= 5.63D-02 1.22D-01. 

      3 vectors produced by pass  2 Test12= 3.17D-15 3.33D-08 XBig12= 7.24D-03 3.79D-02. 

      3 vectors produced by pass  3 Test12= 3.17D-15 3.33D-08 XBig12= 2.25D-04 7.06D-03. 

      3 vectors produced by pass  4 Test12= 3.17D-15 3.33D-08 XBig12= 4.04D-06 8.17D-04. 

      3 vectors produced by pass  5 Test12= 3.17D-15 3.33D-08 XBig12= 2.96D-08 7.41D-05. 

      3 vectors produced by pass  6 Test12= 3.17D-15 3.33D-08 XBig12= 3.37D-10 9.10D-06. 

      2 vectors produced by pass  7 Test12= 3.17D-15 3.33D-08 XBig12= 1.95D-12 5.99D-07. 

      1 vectors produced by pass  8 Test12= 3.17D-15 3.33D-08 XBig12= 9.82D-15 4.57D-08. 

 Inverted reduced A of dimension    24 with in-core refinement. 

 End of Minotr Frequency-dependent properties file   721 does not exist. 

 End of Minotr Frequency-dependent properties file   722 does not exist. 

 Symmetrizing basis deriv contribution to polar: 

 IMax=3 JMax=2 DiffMx= 0.00D+00 

 G2DrvN: will do     4 centers at a time, making    1 passes doing MaxLOS=2. 

 Calling FoFCou, ICntrl=  3107 FMM=F I1Cent=   0 AccDes= 0.00D+00. 

 FoFDir/FoFCou used for L=0 through L=2. 

 End of G2Drv Frequency-dependent properties file   721 does not exist. 

 End of G2Drv Frequency-dependent properties file   722 does not exist. 
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Výstupní soubor IX 

 Full mass-weighted force constant matrix: 

 Low frequencies ---  -40.7995   -0.0019   -0.0015    0.0005   37.6815   55.2358 

 Low frequencies --- 1774.9584 4112.7795 4211.8138 

 Harmonic frequencies (cm**-1), IR intensities (KM/Mole), Raman scattering 

 activities (A**4/AMU), depolarization ratios for plane and unpolarized 

 incident light, reduced masses (AMU), force constants (mDyne/A), 

 and normal coordinates: 

                     1                      2                      3 

                    A1                     A1                     B2 

 Frequencies --  1774.9584              4112.7795              4211.8137 

 Red. masses --     1.0818                 1.0460                 1.0821 

 Frc consts  --     2.0080                10.4246                11.3093 

 IR Inten    --    80.8414                21.1644                60.8089 

 Raman Activ --     4.7861                68.9225                34.7495 

 Depolar (P) --     0.5271                 0.1703                 0.7500 

 Depolar (U) --     0.6903                 0.2910                 0.8571 

  Atom  AN      X      Y      Z        X      Y      Z        X      Y      Z 

     1   8     0.00   0.00   0.07     0.00   0.00   0.05     0.00   0.07   0.00 

     2   1     0.00  -0.43  -0.56     0.00   0.58  -0.40     0.00  -0.56   0.43 

     3   1     0.00   0.43  -0.56     0.00  -0.58  -0.40     0.00  -0.56  -0.43 

6(5) vibrací musí mít nízké frekvence 
(ideálně nulové) – 3 translační a 3 
rotační stupně volnosti systému 

frekvence 
normálních vibrací 

směr pohybů atomů pro 
normální vibraci 
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Výstupní soubor X 

 ------------------- 

 - Thermochemistry - 

 ------------------- 

 Temperature   298.150 Kelvin.  Pressure   1.00000 Atm. 

....  

 Zero-point correction=                           0.023008 (Hartree/Particle) 

 Thermal correction to Energy=                    0.025843 

 Thermal correction to Enthalpy=                  0.026787 

 Thermal correction to Gibbs Free Energy=         0.005411 

 Sum of electronic and zero-point Energies=            -76.004045 

 Sum of electronic and thermal Energies=               -76.001211 

 Sum of electronic and thermal Enthalpies=             -76.000267 

 Sum of electronic and thermal Free Energies=          -76.021642 

                       

                     E (Thermal)             CV                S 

                      KCal/Mol        Cal/Mol-Kelvin    Cal/Mol-Kelvin 

 Total                   16.216              5.989             44.988 

 Electronic               0.000              0.000              0.000 

 Translational            0.889              2.981             34.608 

 Rotational               0.889              2.981             10.376 

 Vibrational             14.439              0.028              0.004 

http://gaussian.com/g_whitepap/thermo.htm 

kráceno 

podmínky 

Je použit model ideálního plynu! 

Gibbsova energie 

energie vibrací pro 
základní stav 

lVRTmoptmk
EREE

,,
)( 

E(RHF) =  -76.0270533118 
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Výstupní soubor XI 

 Counterpoise: corrected energy =    -152.060077655641 

 Counterpoise: BSSE energy =       0.002829142358 

7. Výpočet s korekcí na BSSE 

energie komplexu s korekcí na BSSE 
velikost chyby 
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Extrakce dat - optimalizace 
1) Aktivace modulu qmutil: 
 
 $ module add qmutil 

 
2) Zobrazení průběhu optimalizace (energie): 
 
 $ extract-gopt-ene soubor.log 

 
3) Průběh optimalizace (všechny geometrie): 
 

 $ extract-gopt-xyz soubor.log > soubor_opt.xyz 

 
4) Získání optimalizované geometrie (poslední): 
 

 $ extract-xyz-str soubor_opt.xyz last > soubor_last.xyz 

pouze jednou v daném terminálu 

Je vhodné analyzovat průběh optimalizace, např. v programu vmd nebo Avogadro 
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Extrakce dat – optimalizace, pokr. 
Průběh optimalizace (energie): 

$ extract-gopt-ene soubor.log  

# Coordinate:  

# Step      Energy [kcal/mol]  Energy [au]        

# --------- ------------------ ------------------ 

          1              0.000       -0.028650961 

          2             -0.171       -0.028922822 

          3             -0.188       -0.028950914 

          4             -0.190       -0.028953934 

 

číslo optimalizačního 
kroku 

relativní energie vůči 
výchozí geometrii 

Energie optimalizované struktury, tedy geometrie obsažené v soubor_last.xyz  v Hartree. 
Geometrii soubor_last.xyz si můžeme prohlédnout v programu Avogadro, Nemesis, vmd.  

absolutní energie v 
Hartree 
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Infinity 
https://lcc.ncbr.muni.cz/whitezone/development/infinity/ 
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Přehled příkazů 

Správa software: 
• module  aktivace/deaktivace software 
 

Správa úloh: 
• psubmit  zadání úlohy do dávkového systému 
• pinfo informace o úloze 
• pgo  přihlásí uživatele na výpočetní uzel, kde se úloha vykonává 
• pjobs přehled úloh uživatele zadaných do dávkového systému 
 
 

Další  užitečné příkazy: pqueues, pnodes, pqstat  
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Životní cyklus úlohy 

...... ...... ...... fr
o

n
ty

 (
q

u
e

u
e

s)
 short normal long 

torque-server (pbs_server) 

stav uzlů 
(nodes) 

pnodes 

pjobs 
pqstat  
pqueues 

torque-scheduler (pbs_sched) 

řazení úloh na výpočetní uzly 
dle požadovaných zdrojů 

torque-mom 
(pbs_mom) 

torque-mom 
(pbs_mom) 

výpočetní uzel#1 
np=2 

výpočetní uzel#2 
np=1 

psubmit psubmit 
psubmit 

připravená úloha 
čekající úloha 
běžící úloha 



C7800 Počítačová chemie a molekulové modelování I - cvičení -47- 

Úloha 

Úloha musí splňovat následující podmínky: 

• každá úloha se spouští v samostatném adresáři 

• všechny vstupní data úlohy musí být v adresáři úlohy 

• adresáře úloh nesmí být do sebe zanořené 

• průběh úlohy je řízen skriptem nebo vstupním souborem (u automaticky 
detekovaných úloh) 

• skript úlohy musí být v bashi 

•  ve skriptu úlohy se nesmí používat absolutní cesty, všechny cesty musí být uvedeny 
relativně k adresáři úlohy 

/home/kulhanek 

job1 

job2 

/home/kulhanek 

job1 

job2 
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Spuštění úlohy v gaussianu 
Úlohy v programu Gaussian budeme spouštět vždy přes rozhraní Infinity. Úlohy budeme 
spouštět na 1 CPU ve frontě normal, kde výpočetní uzel bude vaše pracovní stanice. 
 
 
$ module add gaussian 

$ psubmit localhost@normal soubor.com 

aktivace modulu gaussian 
pouze jednou v daném terminálu 

vstupní soubor pro program gaussian 
úloha bude zařazena do fronty normal 
(max imální doba běhu úlohy 12 hodin) 
běh úlohy je omezen pouze na vaší 
pracovní stanici  

Po doběhnutí úlohy bude výsledek výpočtu uložen v souboru soubor.log 
 

K monitorování průběhu úlohy lze použít příkaz pinfo, který se spouští v adresáři úlohy. 
Dalšími možnostmi jsou příkazy pjobs a pqstat.  
 

Pokud je úloha spuštěna, je možné použít příkaz pgo, který vás příhlásí na výpočetní uzel a 
změní aktuální adresář do pracovního adresáře úlohy. Lze tak kontrolovat průběh výpočtu 
za běhu úlohy. 
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Servisní soubory 
V adresáři úlohy vznikají při zadání úlohy do dávkového systému a dále v průběhu života 
úlohy a po jejím ukončení servisní soubory.  Jedná se o textové soubory, které je možné 
analyzovat pomocí libovolného textového prohlížeče (příkazy less, more) či editoru (vi, 
kwrite, gedit). Pro účely cvičení je možné obsah souborů ignorovat, kromě případů, kdy 
úloha nedoběhne v pořádku. 

Význam souborů je následující: 

•  *.info kontrolní soubor s informacemi o průběhu úlohy 

•  *.infex vlastní skript (wrapper), který se spouští dávkovým systémem 

•  *.infout standardní výstup z běhu *.infex skriptu, nutno analyzovat při  
  nestandardním ukončení úlohy 

•  *.nodes seznam uzlů vyhrazených pro úlohu 

•  *.gpus seznam GPU karet vyhrazenych pro úlohu 

•  *.key unikátní identifikátor úlohy 

•  *.stdout standardní výstup z běhu skriptu úlohy, nutno analyzovat při  
  nestandardním ukončení úlohy 
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Přenos dat 
Typ synchronizace Význam 

sync Data úlohy jsou při spuštění úlohy zkopírována ze vstupního 
adresáře do pracovního adresáře. Pak je spuštěn vlastní výpočet. Po 
jeho doběhnutí jsou všechna data z pracovního adresáře 
zkopírována zpět do vstupního adresáře úlohy. 

Uživatelské rozhraní (UI) 
(Frontend) 

/job/input/dir 

Výpočetní uzel #1 
Worker Node (WN) 

/scratch/job_id/ 

rsync 

rsync 

Poznámky:  
• výchozí synchronizační mód 
• při použití localhost@normal je výpočetní uzel a uživatelské rozhraní identický stroj 
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Nemesis 
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Vizualizace optimalizace geometrie 
1) Projekt: Trajectory 
2) File->Import Trajectory as -> Gaussian Geometry Optimization 

dvojklik 

dvojklik 

průběh optimalizace 
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Vizualizace vibrací 
1) Projekt: Trajectory 
2) File->Import Trajectory as -> Gaussian Vibrations 

dvojklik dvojklik 

zvolíme vibraci 

spustíme animaci 
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Avogadro 
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Vizualizace vibrací 

Do programu Avogadro načteme soubor.log, obsahující výsledky vibrační analýzy. Souhrn 
frekvencí jednotlivých normálních vibrací najdeme v menu Extensions->Vibrations.  

frekvence vibrací vizualizace vibrací 
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VMD 
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Vizualizace optimalizace geometrie 

Do programu načteme xyz trajektorii (průběh optimalizace) vyextrahovanou skriptem 
extract-gopt-xyz z modulu qmutil. 

počet optimalizačních kroků 

přesouvání mezi jednotlivými geometriemi 
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Vizualizace volumetrických dat 

Volumetrické data (cube soubory vytvořené programem cubegen) lze načíst přímo do 
programu vmd. Ve výchozí vizualizaci se zobrazí molekula v čárovém modelu bez 
volumetrických dat. 
 
Volumetrická data lze zobrazit jako (Representations): 

• isoplochu (isosurface) 
• řez (volumeslice) 
 

Mapování elektrostatického potenciálu na isoplochu elektronové hustoty: 
1)  načteme hustotu a elektrostatický potenciál do jedné molekuly 
2) zobrazíme isoplochu elektronové hustoty 
3) pro isoplochu zvolíme vybarvení (Coloring Method) podle volumetrických dat 

(Volume) - zvolíme elektrostatický potenciál, škála barev se nastavuje na 
záložce Trajectory (Color Scale Data Range) 
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Extrapolace na CBS 
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Extrapolace 

Bx

CBS
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
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Protože máme čtyři vstupní energie (pro x=2, 3, 4, a 5) a jen tři neznámé  (ECBS, A a B) 
musíme použít metodu nejmenších čtverců. Cílem metody je nalézt hodnotu parametrů 
ECBS, A a B tak, aby účelová (chybová) funkce byla minimální. 
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K hledání optimálních parametrů můžeme použít metodu fit z programu gnuplot.  

Viz originální dokumentace gnuplotu nebo: 
http://www.root.cz/clanky/gnuplot-prikaz-fit/ 
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Postup 
 Připravíme textový soubor data.txt, který bude obsahovat dva sloupce: kardinální číslo 

báze (2, 3, 4, ...) a vypočtenou energii metodou HF. 
 

 Spustíme program gnuplot a zobrazíme průběh energie ze souboru data.txt: 
 
 

 Definujeme funkci pro extrapolaci: 
 
 

 Nastavíme výchozí hodnoty parametru pro optimalizaci: 
 
 
 
 

 Provedeme před-optimalizaci parametrů (ECBS a A a pak finální optimalizaci všech 
parametrů: 
 
 
 
 

gnuplot> plot './data.txt' using 1:2 with points 

gnuplot> E(x) = Ecbs + A*exp(-B*x) 

gnuplot> A=1 

gnuplot> B=1 

gnuplot> Ecbs=-80  # nizsi nez nejmensi vypoctena energie 

gnuplot> fit E(x) "./data.txt" via Ecbs, A 

gnuplot> fit E(x) "./data.txt" via Ecbs, A, B 
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Postup, pokračování 
 Zobrazíme vstupní data, funkci E(x) a hodnotu ECBS. Provedeme vizuální kontrolu 

získaných výsledů. Funkce E(x) musí procházet všemi body a limitně se blížit nalezené 
hodnotě ECBS. 
 
 
 
 

 Vypíšeme přesnou hodnotu ECBS 

 
 

 
 
 
 

gnuplot> set xrange[2:7] 

gnuplot> plot './data.txt' using 1:2 with points, E(x), Ecbs 

gnuplot> print Ecbs 


